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UNIT I 

 

INTRODUCTION TO COMPUTER 

 

The word computer is derived from the word compute. Compute means to calculate. The 

computer was originally defined as a super fast calculator. It had the capacity to solve complex 

arithmetic and scientific problems at very high speed. But nowadays in addition to handling 

complex arithmetic computations, computers perform many other tasks like accepting, sorting, 

selecting, moving, comparing various types of information. They also perform arithmetic and 

logical operations on alphabetic, numeric and other types of information. This information 

provided by the user to the computer is data. The information in one form which is presented to 

the computer is the input information or input data. 

Information in another form is presented by the computer after performing a process on it. This 

information is the output information or output data. 

The set of instructions given to the computer to perform various operations is called as the 

computer program. 

The process of converting the input data into the required output form with the help of the 

computer program is called as data processing. The computers are therefore also referred to as 

data processors Therefore a computer can now be defined as a fast and accurate data processing 

system that accepts data, performs various operations on the data, has the capability to store the 

data and produce the results on the basis of detailed step by step instructions given to it. The 

terms hardware and software are almost always used in connection with the computer. 

• The Hardware: The hardware is the machinery itself. It is made up of the physical parts or 

devices of the computer system like the electronic Integrated Circuits (ICs), magnetic storage 

media and other mechanical devices like input devices, output devices etc. All these various 

hardware are linked together to form an effective functional unit. The various types of hardware 

used in the computers, has evolved from vacuum tubes of the first generation to Ultra Large 

Scale Integrated Circuits of the present generation. 

• The Software: The computer hardware itself is not capable of doing anything on its own. It has 

to be given explicit instructions to perform the specific task. The computer program is the one 

which controls the processing activities of the computer. The computer thus functions according 

to the instructions written in the program. Software mainly consists of these computer programs, 
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procedures and other documentation used in the operation of a computer system. Software is a 

collection of programs which utilize and enhance the capability of the hardware. 

 

 CLASSIFICATION OF COMPUTERS 

Computers are broadly classified into two categories depending upon the logic used in their 

design as: 

Analog computers: In analog computers, data is recognized as a continuous measurement of a 

physical property like voltage, speed, pressure etc. Readings on a dial or graphs are obtained as 

the output, ex. Voltage, temperature; pressure can be measured in this way. 

Digital Computers: These are high speed electronic devices. These devices are programmable. 

They process data by way of mathematical calculations, comparison, sorting etc. They accept 

input and produce output as discrete signals representing high (on) or low (off) voltage state of 

electricity. Numbers, alphabets, symbols are all represented as a series of 1s and Os. Digital 

Computers are further classified as General Purpose Digital Computers and Special Purpose 

Digital Computers. General Purpose computers can be used for any applications like accounts, 

payroll, data processing etc. Special purpose computers are used for a specific job like those used 

in automobiles, microwaves etc. Another classification of digital computers is done on the basis 

of their capacity to access memory and size like: 

Small Computers: I) Microcomputers: Microcomputers are generally referred to as Personal 

Computers (PCs). They have Smallest memory and less power. They are widely used in day to 

day applications like office automation, and professional applications, ex. PCAT, Pentium etc. 

II) Note Book and Laptop Computers: These are portable in nature and are battery operated. 

Storage devices like CDs, floppies etc. and output devices like printers can be connected to these 

computers. Notebook computers are smaller in physical size than lap top computers. However, 

both have powerful processors, support graphics, and can accept mouse driven input. 

 
Hand Held Computers: These types of computers are mainly used in applications like 

collection of field data. They are even smaller than the note book computers. 

 
Hybrid Computers: Hybrid Computers are a combination of Analog and Digital computers. 

They combine the speed of analog computers and accuracy of digital computers. They are mostly 
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used in specialized applications where the input data is in an analog form i.e. measurement. This 

is converted into digital form for further processing. The computers accept data from sensors and 

produce output using conventional input/output devices. 

 
Mini Computers: Mini computers are more powerful than the micro computers. They have 

higher memory capacity and more storage capacity with higher speeds. These computers are 

mainly used in process control systems. They are mainly used in applications like payrolls, 

financial accounting, Computer aided design etc. ex. VAX, PDP-11 

 
Mainframe Computers: Main frame computers are very large computers which process data at 

very high speeds of the order of several million instructions per second. They can be linked into 

a network with smaller computers, micro computers and with each other. They are typically used 

in large organizations, government departments etc. ex. IBM4381, CDC 

 
Super Computers: A super computer is the fastest, most powerful and most expensive 

computer which is used for complex tasks that require a lot of computational power. Super 

computers have multiple processors which process multiple instructions at the same time. This is 

known as parallel processing. These computers are widely used in very advanced applications 

like weather forecasting, processing geological data etc. 

 

APPLICATIONS OF COMPUTERS 

Today computers find widespread applications in all activities of the modern world. Some of the 

major application areas include: 

Scientific, Engineering and Research: This is the major area where computers find vast 

applications. They are used in areas which require lot of experiments, mathematical calculations, 

weather forecasting, and complex mathematical and engineering applications. Computer Aided 

Design (CAD) and Computer Aided Manufacturing (CAM) help in designing robotics, 

automobile manufacturing, automatic process control devices etc. 

Business: Record keeping, budgets, reports, inventory, payroll, invoicing, accounts are all the 

areas of business and industry where computers are used to a great extent. Database management 

is one of the major area where computers are used on a large scale. The areas of application here 
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include banking, airline reservations, etc. where large amounts of data need to be updated, 

edited, sorted, searched from large databases. 

Medicine: Computerized systems are now in widespread use in monitoring patient data like , 

pulse rate, blood pressure etc. resulting in faster and accurate diagnosis. Modern day medical 

equipment are highly computerized today. Computers are also widely used in medical research. 

Information: This is the age of information. Television, Satellite communication, Internet, 

networks are all based on computers. 

Education: The use of computers in education is increasing day by day. The students develop 

the habit of thinking more logically and are able to formulate problem solving techniques. CDs 

on a variety of subjects are available to impart education. On line training programs for students 

are also becoming popular day by day. All the major encyclopedias, dictionaries and books are 

now available in the digital form and therefore are easily accessible to the student of today. 

Creativity in drawing, painting, designing, decoration, music etc. can be well developed with 

computers. 

Games and Entertainment: Computer games are popular with children and adults alike. 

Computers are nowadays also used in entertainment areas like movies, sports, advertising etc. 

 

Advantages of Computers: 

Speed: The speed of a computer is measured in terms of the number of instructions that it can 

perform or execute in a second. The speeds of computers are measured in milliseconds (10~3 

sec), micro-seconds (10*6 sec), and nano-seconds (10~9sec). Computers are superfast machines 

and can process millions of instructions per second. Smaller computers can execute thousands of 

instructions per second, while the more complex machines can execute millions of instructions 

per second. 

Accuracy: Computers are very accurate. They are capable of executing hundreds of instructions 

without any errors. They do not make mistakes in their computations. They perform each and 

every calculation with the same accuracy. 

Efficiency: The efficiency of computers does not decrease with age. The computers can perform 

repeated tasks with the same efficiency any number of times without exhausting there selves. 

Even if they are instructed to execute millions of instructions, they are capable of executing them 

all with the same speed and efficiency without exhaustion. 
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Storage Capability: Computers are capable of storing large amounts of data in their storage 

devices. These dev ices occupy very less space and can store millions of characters in condensed 

forms. These storage devices typically include floppy disks, tapes, hard disks, CDs etc, the data 

stored on these devices can be retrieved and reused whenever it is required in future 

Versatility: Computers are very versatile. They are capable not only of performing complex 

mathematical tasks of science and engineering, but also other non numerical operations fielding 

air-line reservation, electricity bills, data base management etc. Limitations of Computers: 

Although the computers of today are highly intelligent and sophisticated they have their own 

limitations. The computer cannot think on its own, since it does not have its own brain. It can 

only do what is has been programmed to do. It can execute only those jobs that can be expressed 

as a finite set of instructions to achieve a specific goal. Each of the steps has to be clearly 

defined. The computers do not learn from previous experience nor can they arrive at a conclusion 

without going through all the intermediate steps. However the impact of computers on today’s 

society in phenomenal and they are today an important part of the society. 

 

 COMPUTER ARCHITECTURE 
 

 

Any system is defined as a group of integrated parts which are designed to achieve a common 

objective. Thus, a system is made up of more than one element or part, where each element 

performs a specific function and where all the elements (parts) are logically related and are 

controlled in such a way that the goal (purpose) of the system is achieved. 

A computer is made up of a number of integrated elements like – 

The central processing unit 

The input and output devices 

The storage devices. 

Each of these units performs a specific task. However, none of them can function independently 

on their own. They are logically related and controlled to achieve a specific goal. When they are 

thus integrated they form a fully fledged computer system. 

 
COMPONENTS OF A COMPUTER SYSTEM 

The basic parts of computer system are: 
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 Input Unit 

 The Central Processing Unit 

 Output Unit 

 

The Input Unit: Input devices are the dev ices which are used to feed programs and data to the 

computer. The input system connects the external environment with the computer system. The 

input devices are the means of communication between the user and the computer system. 

Typical input devices include the keyboard, floppy disks, mouse, microphone, light pen, joy 

stick, magnetic tapes etc. The way in which the data is fed into the computer through each of 

these devices is different. However, a computer can accept data only in a specific form. 

Therefore these input devices transform the data fed to them, into a form which can be accepted 

by the computer. These devices are a means of communication and inter 1 station between the 

user and the computer systems. 

Thus the functions of the input unit are: 

 Accept information (data) and programs. 

 Convert the data in a form which the computer can accept. 

 Provide this converted data to the computer for further processing. 

 

The Central Processing Unit: This is the brain of any computer system. The central processing 

unit or CPU is made of three parts: 

 The control unit 

 The arithmetic logic unit 

 Te primary storage unit 

 

The Control Unit: The Control Unit controls the operations of the entire computer system. The 

control unit gets the instructions from the programs stored in primary storage unit interprets these 

instruction an subsequently directs the other units to execute the instructions. Thus it manages 

and coordinates the entire computer system. 

The Arithmetic Logic Unit: The Arithmetic Logic Unit (ALU) actually executes the 

instructions and performs all the calculations and decisions. The data is held in the primary 

storage unit and transferred to the ALU whenever needed. Data can be moved from the primary 



9 
 

storage to the arithmetic logic unit a number of times before the entire processing is complete. 

After the completion, the results are sent to the output storage section and the output devices. 

The Primary Storage Unit: This is also called as Main Memory. Before the actual processing 

starts the data and the instructions fed to the computer through the input units are stored in this 

primary storage unit. Similarly, the data which is to be output from the computer system is also 

temporarily stored in the primary memory. It is also the area where intermediate results of 

calculations are stored. The main memory has the storage section that holds the computer 

programs during execution. 

Thus the primary unit: 

 Stores data and programs during actual processing 

 Stores temporary results of intermediate processing 

 Stores results of execution temporarily 

 

Output Unit: The output devices give the results of the process and computations to the outside 

world. The output units accept the results produced by the computer, convert them into a human 

readable form and supply them to the users. The more common output devices are printers, 

plotters, display screens, magnetic tape drives etc. 

 

 Number System 
 

 

The language we use to communicate with each other is comprised of words and characters. We 

understand numbers, characters and words. But this type of data is not suitable for computers. 

Computers only understand the numbers. So, when we enter data, the data is converted into 

electronic pulse. Each pulse is identified as code and the code is converted into numeric format 

by ASCII. It gives each number, character and symbol a numeric value (number) that a computer 

understands. So to understand the language of computers, one must be familiar with the number 

systems. 

 

The Number Systems used in computers are: 

 
o Binary number system 
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o Octal number system 

o Decimal number system 

o Hexadecimal number system 

 
Binary number system 

 
It has only two digits '0' and '1' so its base is 2. Accordingly, In this number system, there are 

only two types of electronic pulses; absence of electronic pulse which represents '0'and presence 

of electronic pulse which represents '1'. Each digit is called a bit. A group of four bits (1101) is 

called a nibble and group of eight bits (11001010) is called a byte. The position of each digit in a 

binary number represents a specific power of the base (2) of the number system. 

 

Octal number system 

 
It has eight digits (0, 1, 2, 3, 4, 5, 6, 7) so its base is 8. Each digit in an octal number represents a 

specific power of its base (8). As there are only eight digits, three bits (23=8) of binary number 

system can convert any octal number into binary number. This number system is also used to 

shorten long binary numbers. The three binary digits can be represented with a single octal digit. 

 

Decimal number system 

 
This number system has ten digits (0, 1, 2, 3, 4, 5, 6, 7, 8, 9) so its base is 10. In this number 

system, the maximum value of a digit is 9 and the minimum value of a digit is 0. The position of 

each digit in decimal number represents a specific power of the base (10) of the number system. 

This number system is widely used in our day to day life. It can represent any numeric value. 

 

Hexadecimal number system 

 
This number system has 16 digits that ranges from 0 to 9 and A to F. So, its base is 16. The A to 

F alphabets represent 10 to 15 decimal numbers. The position of each digit in a hexadecimal 

number represents a specific power of base (16) of the number system. As there are only sixteen 

digits, four bits (24=16) of binary number system can convert any hexadecimal number into 
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binary number. It is also known as alphanumeric number system as it uses both numeric digits 

and alphabets. 

 

Binary arithmetic is essential part of all the digital computers and many others 

digital system. 
 

Binary Addition 

 

It is a key for  binary subtraction, multiplication, division. There  are four  rules of binary 

addition. 
 

In fourth case, a binary addition is creating a sum of (1 + 1 = 10) i.e. 0 is written in the given 

column and a carry of 1 over to the next column. 

Example − Addition 

 

 
Binary Subtraction 

 

Subtraction and Borrow, these two words will be used very frequently for the binary 

subtraction. There are four rules of binary subtraction. 
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Example − Subtraction 

 
 

Binary Multiplication 

 

Binary multiplication is similar to decimal multiplication. It is simpler than decimal 

multiplication because only 0s and 1s are involved. There are four rules of binary 

multiplication. 
 

Example − Multiplication 

 

 
Binary Division 

 

Binary division is similar to decimal division. It is called as the long division procedure. 
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Example − Division 
 

 

 COMPLEMENTS 
 

 

Complements are used in the digital computers in order to simplify the subtraction operation and 

for the logical manipulations. For each radix-r system (radix r represents base of number system) 

there are two types of complements. 

 

S.N. Complement Description 

1 Radix Complement The radix complement is referred to as the r's 

complement 

2 Diminished Radix Complement The diminished radix complement is referred to as the (r- 

1)'s complement 

 

Binary system complements 

 

As the binary system has base r = 2. So the two types of complements for the binary system are 

2's complement and 1's complement. 

1's complement 

The 1's complement of a number is found by changing all 1's to 0's and all 0's to 1's. This is 

called as taking complement or 1's complement. Example of 1's Complement is as follows. 
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2's complement 

The 2's complement of binary number is obtained by adding 1 to the Least Significant Bit 

(LSB) of 1's complement of the number. 

2's complement = 1's complement + 1 

Example of 2's Complement is as follows. 

 

 

 LOGIC GATES, TRUTH TABLE 
 

Logic gates are the basic building blocks of any digital system. It is an electronic circuit having 

one or more than one input and only one output. The relationship between the input and the 

output is based on a certain logic. Based on this, logic gates are named as AND gate, OR gate, 

NOT gate etc. 

 

AND Gate : A circuit which performs an AND operation is shown in figure. It has n input (n >= 

2) and one output. 
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Logic diagram 
 

 
Truth Table 

 

 
OR Gate: A circuit which performs an OR operation is shown in figure. It has n input (n >= 2) 

and one output. 

 

 
Logic diagram 

 

 
Truth Table 
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NOT Gate: NOT gate is also known as Inverter. It has one input A and one output Y. 
 
 

 
Logic diagram 

 

 
Truth Table 

 

 

NAND Gate 

 
A NOT-AND operation is known as NAND operation. It has n input (n >= 2) and one output. 

 

 
Logic diagram 
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Truth Table 
 

 
NOR Gate 

 
A NOT-OR operation is known as NOR operation. It has n input (n >= 2) and one output. 

 

 

 

Logic diagram 
 

 

Truth Table 
 

 
XOR Gate : XOR or Ex-OR gate is a special type of gate. It can be used in the half adder, 

full adder and subtractor. The exclusive-OR gate is abbreviated as EX-OR gate or sometime 

as X-OR gate. It has n input (n >= 2) and one output. 
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Logic diagram 
 

 
Truth Table 

 

 
XNOR Gate 

 
XNOR gate is a special type of gate. It can be used in the half adder, full adder and subtractor. 

The exclusive-NOR gate is abbreviated as EX-NOR gate or sometime as X-NOR gate. It has n 

input (n >= 2) and one output. 

 

 
Logic diagram 
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Truth Table 
 

 BOOLEAN ALGEBRA 
 

Boolean Algebra is used to analyze and simplify the digital (logic) circuits. It uses only the 

binary numbers i.e. 0 and 1. It is also called as Binary Algebra or logical Algebra. Boolean 

algebra was invented by George Boole in 1854. 

 

Rule in Boolean Algebra 

 
Following are the important rules used in Boolean algebra. 

 

 Variable used can have only two values. Binary 1 for HIGH and Binary 0 for LOW. 

 

 Complement of a variable is represented by an overbar (-). Thus, complement of variable 

B is represented as  . Thus if B = 0 then   = 1 and B = 1 then   = 0. 

 ORing of the variables is represented by a plus (+) sign between them. For example 

ORing of A, B, C is represented as A + B + C. 

 Logical ANDing of the two or more variable is represented by writing a dot between 

them such as A.B.C. Sometime the dot may be omitted like ABC. 

 

Boolean Laws 

 
There are six types of Boolean Laws. 

 
Commutative law 
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Any binary operation which satisfies the following expression is referred to as commutative 

operation. 

 

Commutative law states that changing the sequence of the variables does not have any effect on 

the output of a logic circuit. 

Associative law 
 

This law states that the order in which the logic operations are performed is irrelevant as their 

effect is the same. 

 

 
Distributive law 

 

Distributive law states the following condition. 
 

 
AND law 

 

These laws use the AND operation. Therefore they are called as AND laws. 
 

 
OR law 

 

These laws use the OR operation. Therefore they are called as OR laws. 
 

 
INVERSION law 

 

This law uses the NOT operation. The inversion law states that double inversion of a variable 

results in the original variable itself. 
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 TABLE SIMPLIFICATION OF BOOLEAN FUNCTION. 
 

Boolean algebra deals with binary variables and logic operation. A Boolean Function is 

described by an algebraic expression called Boolean expression which consists of binary 

variables, the constants 0 and 1, and the logic operation symbols. Consider the following 

example. 

 

Here the left side of the equation represents the output Y. So we can state equation no. 1 
 

 
Truth Table Formation: A truth table represents a table having all combinations of inputs and 

their corresponding result. It is possible to convert the switching equation into a truth table. For 

example, consider the following switching equation. 

 

The output will be high (1) if A = 1 or BC = 1 or both are 1. The truth table for this equation is 

shown by Table (a). The number of rows in the truth table is 2n where n is the number of input 

variables (n=3 for the given equation). Hence there are 23 = 8 possible input combination of 

inputs. 

 

 
Methods to simplify the boolean function 

 
The methods used for simplifying the Boolean function are as follows − 
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 Karnaugh-map or K-map, and 

 NAND gate method. 

 
Karnaugh-map or K-map 

 
The Boolean theorems and the De-Morgan's theorems are useful in manipulating the logic 

expression. We can realize the logical expression using gates. The number of logic gates 

required for the realization of a logical expression should be reduced to a minimum possible 

value by K-map method. This method can be done in two different ways, as discussed below. 

Sum of Products (SOP) Form 
 

It is in the form of sum of three terms AB, AC, BC with each individual term is a product of 

two variables. Say A.B or A.C etc. Therefore such expressions are known as expression in SOP 

form. The sum and products in SOP form are not the actual additions or multiplications. In fact 

they are the OR and AND functions. In SOP form, 0 represents a bar and 1 represents an unbar. 

SOP form is represented by . 

Given below is an example of SOP. 
 

 
Product of Sums (POS) Form 

 

It is in the form of product of three terms (A+B), (B+C), or (A+C) with each term is in the form 

of a sum of two variables. Such expressions are said to be in the product of sums (POS) form. In 

POS form, 0 represents an unbar and 1 represents a bar. POS form is represented by . 
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Given below is an example of POS. 
 
 

 

NAND gates Realization 

 
NAND gates can be used to simplify Boolean functions as shown in the example below. 
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UNIT II 

 
 

 Introduction to Computer Software 
 

Software is a set of programs, which is designed to perform a well-defined function. A program 

is a sequence of instructions written to solve a particular problem. 

There are two types of software − 

 
 System Software 

 Application Software 

 
System Software 

 
The system software is a collection of programs designed to operate, control, and extend the 

processing capabilities of the computer itself. System software is generally prepared by the 

computer manufacturers. These software products comprise of programs written in low-level 

languages, which interact with the hardware at a very basic level. System software serves as the 

interface between the hardware and the end users. 

Some examples of system software are Operating System, Compilers, Interpreter, Assemblers,  

etc. 

Here is a list of some of the most prominent features of a system software − 

 
 Close to the system 

 Fast in speed 

 Difficult to design 

 Difficult to understand 

 Less interactive 

 Smaller in size 

 Difficult to manipulate 

 Generally written in low-level language 
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Application Software 

 
Application software products are designed to satisfy a particular need of a particular 

environment. All software applications prepared in the computer lab can come under the 

category of Application software. 

Application software may consist of a single program, such as Microsoft's notepad for writing 

and editing a simple text. It may also consist of a collection of programs, often called a software 

package, which work together to accomplish a task, such as a spreadsheet package.Examples of 

Application software are the following − 

 

 Payroll Software 

 Student Record Software 

 Inventory Management Software 

 Income Tax Software 

 Railways Reservation Software 

 Microsoft Office Suite Software 

 Microsoft Word 

 Microsoft Excel 

 Microsoft PowerPoint 
 

Features of application software are as follows − 

 
 Close to the user 

 Easy to design 

 More interactive 

 Slow in speed 

 Generally written in high-level language 

 Easy to understand 

 Easy to manipulate and use 

 Bigger in size and requires large storage space 
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 Introduction to Computer Software -'C' 
 

A computer program is a sequence of instructions written using a Computer Programming 

Language to perform a specified task by the computer. 

The two important terms that we have used in the above definition are − 

 

 Sequence of instructions 

 Computer Programming Language 

C is a procedural programming language. It was initially developed by Dennis Ritchie in the 

year 1972. It was mainly developed as a system programming language to write an operating 

system. The main features of the C language include low-level memory access, a simple set of 

keywords, and a clean style, these features make C language suitable for system programmings 

like an operating system or compiler development. 

Many later languages have borrowed syntax/features directly or indirectly from the C 

language. Like syntax of Java, PHP, JavaScript, and many other languages are mainly based on 

the C language. C++ is nearly a superset of C language (Few programs may compile in C, but 

not in C++). 

Beginning with C programming: 

 
 

1. Structure of a C program 

After the above discussion, we can formally assess the structure of a C program. By 

structure, it is meant that any program can be written in this structure only. Writing a C 

program in any other structure will hence lead to a Compilation Error. 

The structure of a C program is as follows: 
 

 

https://www.geeksforgeeks.org/c-programming-language/
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The components of the above structure are: 

1. Header Files Inclusion: The first and foremost component is the inclusion of the 

Header files in a C program. A header file is a file with extension .h which contains C 

function declarations and macro definitions to be shared between several source files. 

Some of C Header files: 

 stddef.h – Defines several useful types and macros. 

 stdint.h – Defines exact width integer types. 

 stdio.h – Defines core input and output functions 

 stdlib.h – Defines numeric conversion functions, pseudo-random network generator, 

memory allocation 

 string.h – Defines string handling functions 

 math.h – Defines common mathematical functions 

2. Main Method Declaration: The next part of a C program is to declare the main() 

function. The syntax to declare the main function is: 

Syntax to Declare the main method: 

 
 

int main() 

 
{} 

 
Variable Declaration: The next part of any C program is the variable declaration. It refers 

to the variables that are to be used in the function. Please note that in the C program, no 

variable can be used without being declared. Also in a C program, the variables are to be 

declared before any operation in the function. 

Example: 

 
 

int main() 

{ 

int a; 

 

 
Body: The body of a function in the C program, refers to the operations that are performed in 

the functions. It can be anything like manipulations, searching, sorting, printing, etc. 
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Example: 

 
 

int main() 

{ 

int a; 

 

printf("%d", a); 

 
Return Statement: The last part of any C program is the return statement. The return 

statement refers to the returning of the values from a function. This return statement and return 

value depend upon the return type of the function. For example, if the return type is void, then 

there will be no return statement. In any other case, there will be a return statement and the 

return     value     will     be     of     the     type     of     the     specified     return      type. 

Example: 

 
int main() 

 

{ 

int a; 

printf("%d", a); 

return 0; 

} 
 

Writing first program: 

Following is first program in C 

 

 

#include <stdio.h> 

int main(void) 

{ 

printf("GeeksQuiz"); 

return 0; 

} 
 

1. Let us analyze the program line by line. 

Line 1: [ #include <stdio.h> ] In a C program, all lines that start with # are processed by 

a preprocessor which is a program invoked by the compiler. In a very basic term, 

http://en.wikipedia.org/wiki/C_preprocessor
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the preprocessor takes a C program and produces another C program. The produced 

program has no lines starting with #, all such lines are processed by the preprocessor. In the 

above example, the preprocessor copies the preprocessed code of stdio.h to our file. The .h 

files are called header files in C. These header files generally contain declarations of 

functions. We need stdio.h for the function printf() used in the program. 

Line 2 [ int main(void) ] There must be a starting point from where execution of compiled 

C program begins. In C, the execution typically begins with the first line of main(). The 

void written in brackets indicates that the main doesn’t take any parameter (See this for 

more details). main() can be written to take parameters also. We will be covering that in 

future posts. 

The int was written before main indicates return type of main(). The value returned by 

main indicates the status of program termination. See this post for more details on the 

return type. 

Line 3 and 6: [ { and } ] In C language, a pair of curly brackets define scope and are 

mainly used in functions and control statements like if, else, loops. All functions must start 

and end with curly brackets. 

Line 4 [ printf(“GeeksQuiz”); ] printf() is a standard library function to print something on 

standard output. The semicolon at the end of printf indicates line termination. In C, a 

semicolon is always used to indicate end of a statement. 

Line 5 [ return 0; ] The return statement returns the value from main(). The returned value 

may be used by an operating system to know the termination status of your program. The 

value 0 typically means successful termination. 

 
2. How to execute the above program: 

In order to execute the above program, we need to have a compiler to compile and run our 

programs. There are certain online compilers 

like https://ide.geeksforgeeks.org/, http://ideone.com/, or http://codepad.org/ that can be 

used to start C without installing a compiler. 

Windows: There are many compilers available freely for the compilation of C programs 

like Code Blocks and Dev-CPP. We strongly recommend Code Blocks. 

http://en.wikipedia.org/wiki/C_preprocessor
https://www.geeksforgeeks.org/difference-int-main-int-mainvoid/
https://www.geeksforgeeks.org/fine-write-void-main-cc/
http://www.cplusplus.com/reference/cstdio/printf/
https://ide.geeksforgeeks.org/
http://ideone.com/
http://codepad.org/
http://www.codeblocks.org/downloads/26
http://www.bloodshed.net/download.html
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Linux: For Linux, gcc comes bundled with Linux, Code Blocks can also be used with 

Linux. 

 

  Introduction to Computer Software –DBMS, RDBMS 

Database: Database is a collection of inter-related data which helps in efficient retrieval, 

insertion and deletion of data from database and organizes the data in the form of tables, views, 

schemas, reports etc. For Example, university database organizes the data about students, 

faculty, and admin staff etc. which helps in efficient retrieval, insertion and deletion of data 

from it. 

DDL is short name of Data Definition Language, which deals with database schemas and 

descriptions, of how the data should reside in the database. 

 

function, and triggers) 

structure of the existing database 
 

 

are removed 
 

 

DML is short name of Data Manipulation Language which deals with data manipulation and 

includes most common SQL statements such SELECT, INSERT, UPDATE, DELETE, etc., and 

it is used to store, modify, retrieve, delete and update data in a database. 

CT: retrieve data from a database 
 

 

 

 

 

 

 

http://en.wikipedia.org/wiki/GNU_Compiler_Collection
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Database Management System: The software which is used to manage database is called 

Database Management System (DBMS). For Example, MySQL, Oracle etc. are popular 

commercial DBMS used in different applications. DBMS allows users the following tasks: 

Data Definition: It helps in creation, modification and removal of definitions that define the 

organization of data in database. 

Data Updation: It helps in insertion, modification and deletion of the actual data in the database. 

Data Retrieval: It helps in retrieval of data from the database which can be used by applications 

for various purposes. 

User Administration: It helps in registering and monitoring users, enforcing data security, 

monitoring performance, maintaining data integrity, dealing with concurrency control and 

recovering information corrupted by unexpected failure. 

Paradigm Shift from File System to DBMS 

File System manages data using files in hard disk. Users are allowed to create, delete, and 

update the files according to their requirement. Let us consider the example of file based 

University Management System. Data of students is available to their respective Departments, 

Academics Section, Result Section, Accounts Section, Hostel Office etc. Some of the data is 

common for all sections like Roll No, Name, Father Name, Address and Phone number of 

students but some data is available to a particular section only like Hostel allotment number 

which is a part of hostel office. Let us discuss the issues with this system: 

 Redundancy of data: Data is said to be redundant if same data is copied at many places. If a 

student wants to change Phone number, he has to get it updated at various sections. Similarly, 

old records must be deleted from all sections representing that student. 

 Inconsistency of Data: Data is said to be inconsistent if multiple copies of same data does 

not match with each other. If Phone number is different in Accounts Section and Academics 

Section, it will be inconsistent. Inconsistency may be because of typing errors or not updating 

all copies of same data. 

 Difficult Data Access: A user should know the exact location of file to access data, so the 

process is very cumbersome and tedious. If user wants to search student hostel allotment 

number of a student from 10000 unsorted students’ records, how difficult it can be. 

 Unauthorized Access: File System may lead to unauthorized access to data. If a student gets 

access to file having his marks, he can change it in unauthorized way. 
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+ + + + + + 

| ID | NAME | AGE | ADDRESS | SALARY   | 

+ + + + + + 

| 1 | Ramesh | 32 | Ahmedabad | 2000.00 | 

| 2 | Khilan   | 25 | Delhi | 1500.00 | 

| 3 | kaushik | 23 | Kota | 2000.00 | 

| 4 | Chaitali | 25 | Mumbai | 6500.00 | 

| 5 | Hardik   | 27 | Bhopal | 8500.00 | 

| 6 | Komal | 22 | MP | 4500.00 | 

| 7 | Muffy | 24 | Indore | 10000.00 | 

+ + + + + + 

 No Concurrent Access: The access of same data by multiple users at same time is known as 

concurrency. File system does not allow concurrency as data can be accessed by only one 

user at a time. 

 No Backup and Recovery: File system does not incorporate any backup and recovery of data if 

a file is lost or corrupted.

RDBMS 
 

 RDBMS stands for Relational Database Management System. RDBMS is the basis for SQL, 

and for all modern database systems like MS SQL Server, IBM DB2, Oracle, MySQL, and 

Microsoft Access.

A Relational database management system (RDBMS) is a database management system 

(DBMS) that is based on the relational model as introduced by E. F. Codd. 

 

What is a table? 

 
The data in an RDBMS is stored in database objects which are called as tables. This table is 

basically a collection of related data entries and it consists of numerous columns and rows. 

Remember, a table is the most common and simplest form of data storage in a relational 

database. The following program is an example of a CUSTOMERS table − 
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+ + + + + + 

| 1 | Ramesh | 32 | Ahmedabad | 2000.00 | 

+ + + + + + 

+ + 

| ADDRESS | 

+ + 

| Ahmedabad | 

| Delhi | 

| Kota | 

| Mumbai | 

| Bhopal | 

What is a field? 

 
Every table is broken up into smaller entities called fields. The fields in the CUSTOMERS table 

consist of ID, NAME, AGE, ADDRESS and SALARY. 

A field is a column in a table that is designed to maintain specific information about every 

record in the table. 

 

What is a Record or a Row? 

 
A record is also called as a row of data is each individual entry that exists in a table. For 

example, there are 7 records in the above CUSTOMERS table. Following is a single row of data 

or record in the CUSTOMERS table − 

 

A record is a horizontal entity in a table. 

 
What is a column? 

 
A column is a vertical entity in a table that contains all information associated with a specific 

field in a table. 

For example, a column in the CUSTOMERS table is ADDRESS, which represents location 

description and would be as shown below − 
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What is a NULL value? 

 
A NULL value in a table is a value in a field that appears to be blank, which means a field with 

a NULL value is a field with no value. 

It is very important to understand that a NULL value is different than a zero value or a field that 

contains spaces. A field with a NULL value is the one that has been left blank during a record 

creation. 

 

SQL Constraints 

 
Constraints are the rules enforced on data columns on a table. These are used to limit the type of 

data that can go into a table. This ensures the accuracy and reliability of the data in the database. 

Constraints can either be column level or table level. Column level constraints are applied only 

to one column whereas, table level constraints are applied to the entire table. 

Following are some of the most commonly used constraints available in SQL − 

 

 NOT NULL Constraint − Ensures that a column cannot have a NULL value. 

 

 DEFAULT Constraint − Provides a default value for a column when none is specified. 

 

 UNIQUE Constraint − Ensures that all the values in a column are different. 

 

 PRIMARY Key − Uniquely identifies each row/record in a database table. 

 

 FOREIGN Key − Uniquely identifies a row/record in any another database table. 

 

 CHECK Constraint − The CHECK constraint ensures that all values in a column satisfy 

certain conditions. 

 INDEX − Used to create and retrieve data from the database very quickly. 

 
 

Data Integrity 

| MP | 

| Indore | 

+----+------+ 

https://www.tutorialspoint.com/sql/sql-not-null.htm
https://www.tutorialspoint.com/sql/sql-default.htm
https://www.tutorialspoint.com/sql/sql-unique.htm
https://www.tutorialspoint.com/sql/sql-primary-key.htm
https://www.tutorialspoint.com/sql/sql-foreign-key.htm
https://www.tutorialspoint.com/sql/sql-check.htm
https://www.tutorialspoint.com/sql/sql-index.htm
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The following categories of data integrity exist with each RDBMS − 

 

 Entity Integrity − There are no duplicate rows in a table. 

 

 Domain Integrity − Enforces valid entries for a given column by restricting the type, the 

format, or the range of values. 

 Referential integrity − Rows cannot be deleted, which are used by other records. 

 

 User-Defined Integrity − Enforces some specific business rules that do not fall into 

entity, domain or referential integrity. 

 

Database Normalization 

 
Database normalization is the process of efficiently organizing data in a database. There are two 

reasons of this normalization process − 

 Eliminating redundant data, for example, storing the same data in more than one table. 

 

 Ensuring data dependencies make sense. 

 

Both these reasons are worthy goals as they reduce the amount of space a database consumes 

and ensures that data is logically stored. Normalization consists of a series of guidelines that 

help guide you in creating a good database structure. 

Normalization guidelines are divided into normal forms; think of a form as the format or the 

way a database structure is laid out. The aim of normal forms is to organize the database 

structure, so that it complies with the rules of first normal form, then second normal form and 

finally the third normal form. 

It is your choice to take it further and go to the fourth normal form, fifth normal form and so on, 

but in general, the third normal form is more than enough. 

 

 First Normal Form (1NF) 

 Second Normal Form (2NF) 

 Third Normal Form (3NF) 

https://www.tutorialspoint.com/sql/first-normal-form.htm
https://www.tutorialspoint.com/sql/second-normal-form.htm
https://www.tutorialspoint.com/sql/third-normal-form.htm
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 Implementing Number Sorting 

Given an array arr[] of size N, the task is to sort this array in ascending order in C. 

Examples: 

Input: arr[] = {0, 23, 14, 12, 9} 

Output: {0, 9, 12, 14, 23} 

 

Input: arr[] = {7, 0, 2} 

Output: {0, 2, 7} 

Approach: 

There are many ways by which the array can be sorted in ascending order, like: 

 Selection Sort 

 Binary Sort 

 Merge Sort 

 Radix Sort 

 Insertion Sort, etc 

For simplicity, we will be using Selection Sort in this article. 

The array can be sorted in ascending order by repeatedly finding the minimum element 

(considering ascending order) from unsorted part and putting it at the beginning. The algorithm 

maintains two subarrays in a given array. 

1. The subarray which is already sorted. 

2. Remaining subarray which is unsorted. 

In every iteration of selection sort, the minimum element (considering ascending order) from 

the unsorted subarray is picked and moved to the sorted subarray. 

Below is the implementation of the above approach: 

 

// C program to sort the array in an 

// ascending order using selection sort 

#include <stdio.h> 

void swap(int* xp, int* yp) 

{ 

int temp = *xp; 

*xp = *yp; 

*yp = temp; 

} 

https://www.geeksforgeeks.org/arrays-in-c-cpp/
http://www.geeksforgeeks.org/selection-sort/
https://www.geeksforgeeks.org/binary-search/
http://www.geeksforgeeks.org/merge-sort/
https://www.geeksforgeeks.org/radix-sort/
http://www.geeksforgeeks.org/insertion-sort/
http://www.geeksforgeeks.org/selection-sort/
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// Function to perform Selection Sort 

void selectionSort(int arr[], int n) 

{ 

int i, j, min_idx; 

 

// One by one move boundary of unsorted subarray 

for (i = 0; i < n - 1; i++) { 

 

// Find the minimum element in unsorted array 

min_idx = i; 

for (j = i + 1; j < n; j++) 

if (arr[j] < arr[min_idx]) 

min_idx = j; 
 

// Swap the found minimum element 

// with the first element 

swap(&arr[min_idx], &arr[i]); 

} 

} 
 

// Function to print an array 

void printArray(int arr[], int size) 

{ 

int i; 

for (i = 0; i < size; i++) 

printf("%d ", arr[i]); 

printf("\n"); 

} 
 

// Driver code 

int main() 

{ 

int arr[] = { 0, 23, 14, 12, 9 }; 

int n = sizeof(arr) / sizeof(arr[0]); 

printf("Original array: \n"); 

printArray(arr, n); 

 

selectionSort(arr, n); 

printf("\nSorted array in Ascending order: \n"); 

printArray(arr, n); 
 

return 0; 

} 
 

Output: 
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Original array: 

0 23 14 12 9 

 

Sorted array in Ascending order: 

0 9 12 14 23 

 
Time Complexity: O(N2) 

Auxiliary Space: O(1) 

 

 Matrix addition, Multiplication 
 

 
#include <stdio.h> 

#define N 4 

 

// This function adds A[][] and B[][], and stores 

// the result in C[][] 

void add(int A[][N], int B[][N], int C[][N]) 

{ 

int i, j; 

for (i = 0; i < N; i++) 

for (j = 0; j < N; j++) 

C[i][j] = A[i][j] + B[i][j]; 

} 
 

int main() 

{ 

int A[N][N] = { {1, 1, 1, 1}, 

{2, 2, 2, 2}, 

{3, 3, 3, 3}, 

{4, 4, 4, 4}}; 

 

int B[N][N] = { {1, 1, 1, 1}, 
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{2, 2, 2, 2}, 

{3, 3, 3, 3}, 
{4, 4, 4, 4}}; 

 

int C[N][N]; // To store result 

int i, j; 

add(A, B, C); 

 

printf("Result matrix is \n"); 

for (i = 0; i < N; i++) 

{ 

for (j = 0; j < N; j++) 

printf("%d ", C[i][j]); 

printf("\n"); 

} 
 

return 0; 

} 
 

Output: 

Result matrix is 

2 2 2 2 

4 4 4 4 

6 6 6 6 

8 8 8 8 

 

Matrix Multiplication 

Given two matrices, the task to multiply them. Matrices can either be square or rectangular. 

Examples: 

Input : mat1[][] = {{1, 2}, 

{3, 4}} 

mat2[][] = {{1, 1}, 

{1, 1}} 

Output : {{3, 3}, 

{7, 7}} 

Input : mat1[][] = {{2, 4}, 

{3, 4}} 

mat2[][] = {{1, 2}, 

{1, 3}} 

Output : {{6, 16}, 

{7, 18}} 
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Multiplication of Square Matrices : 

The below program multiplies two square matrices of size 4*4, we can change N for different 

dimensions. 

// C program to multiply two square matrices. 

#include <stdio.h> 

#define N 4 

 

// This function multiplies mat1[][] and mat2[][], 

// and stores the result in res[][] 

void multiply(int mat1[][N], int mat2[][N], int res[][N]) 

{ 

int i, j, k; 

for (i = 0; i < N; i++) { 

for (j = 0; j < N; j++) { 

res[i][j] = 0; 

for (k = 0; k < N; k++) 

res[i][j] += mat1[i][k] * mat2[k][j]; 

} 

} 

} 
 

int main() 

{ 

int mat1[N][N] = { { 1, 1, 1, 1 }, 

{ 2, 2, 2, 2 }, 

{ 3, 3, 3, 3 }, 
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{ 4, 4, 4, 4 } }; 

 

int mat2[N][N] = { { 1, 1, 1, 1 }, 

{ 2, 2, 2, 2 }, 

{ 3, 3, 3, 3 }, 

{ 4, 4, 4, 4 } }; 

 

int res[N][N]; // To store result 

int i, j; 

multiply(mat1, mat2, res); 

 

printf("Result matrix is \n"); 

for (i = 0; i < N; i++) { 

for (j = 0; j < N; j++) 

printf("%d ", res[i][j]); 

printf("\n"); 

} 
 

return 0; 

} 
 

Output 

 
 

Result matrix is 

10 10 10 10 

20 20 20 20 

30 30 30 30 

40 40 40 40 

 
 

 Palindrome checking 

Given an integer N, write a program that returns true if the given number is a palindrome, else 

return false. 

Examples: 

 

Input: N = 2002 

Output: true 

 

Input: N = 1234 

Output: false 
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Approach: 

A simple method for this problem is to first reverse digits of n, then compare the reverse 

of n with n. If both are same, then return true, else false. Below is the implementation of the 

above approach: 

// C program to check whether a number 

// is Palindrome or not. 

#include <stdio.h> 

/* Iterative function to reverse digits of num*/ 

int reverseDigits(int num) 

{ 

int rev_num = 0; 

while (num > 0) { 

rev_num = rev_num * 10 + num % 10; 

num = num / 10; 

} 

return rev_num; 

} 
 

/* Function to check if n is Palindrome*/ 

int isPalindrome(int n) 

{ 

 

// get the reverse of n 

int rev_n = reverseDigits(n); 

 

// Check if rev_n and n are same or not. 

if (rev_n == n) 

return 1; 

https://www.geeksforgeeks.org/write-a-c-program-to-reverse-digits-of-a-number/
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else 

return 0; 
} 

 

/*Driver program to test reversDigits*/ 

int main() 

{ 

int n = 4562; 

printf("Is %d a Palindrome number? -> %s\n", n, 

isPalindrome(n) == 1 ? "true" : "false"); 
 

n = 2002; 

printf("Is %d a Palindrome number? -> %s\n", n, 

isPalindrome(n) == 1 ? "true" : "false"); 

return 0; 

} 
 

Output: 

Is 4562 a Palindrome number? -> false 

Is 2002 a Palindrome number? -> true 

 

 Searching an Element in an Array. 

Problem: Given an array arr[] of n elements, write a function to search a given element 

x in arr[].Examples : 

Input : arr[] = {10, 20, 80, 30, 60, 50, 

110, 100, 130, 170} 

x = 110; 

Output : 6 

Element x is present at index 6 

Input : arr[] = {10, 20, 80, 30, 60, 50, 

110, 100, 130, 170} 

x = 175; 

Output : -1 

Element x is not present in arr[]. 

A simple approach is to do a linear search, i.e 
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 Start from the leftmost element of arr[] and one by one compare x with each element of 

arr[] 

 If x matches with an element, return the index. 

 If x doesn’t match with any of elements, return -1. 
 

Example: 

// C code to linearly search x in arr[]. If x 

// is present then return its location, otherwise 

// return -1 

#include <stdio.h> 

int search(int arr[], int n, int x) 

{ 

int i; 

for (i = 0; i < n; i++) 

if (arr[i] == x) 

return i; 

return -1; 

} 

int main(void) 

{ 

int arr[] = { 2, 3, 4, 10, 40 }; 

int x = 10; 

int n = sizeof(arr) / sizeof(arr[0]); 
 

// Function call 

int result = search(arr, n, x); 

(result == -1) 

? printf("Element is not present in array") 

: printf("Element is present at index %d", result); 

return 0; 

} 
 

Output 

Element is present at index 3 
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UNIT III 

 Ms- word 

A word processor is a computer program used to create and print text documents that 

might otherwise be prepared on a typewriter. The key advantage of a word processor is 

its ability to make changes easily, such as correcting spelling, adding, deleting, 

formatting and relocating text. 

Given below are the basic functions of Microsoft Word: 

 Creating text documents. 

 Editing and Formatting the existing documents. 

 Making a text document interactive with different features and tools. 

 Graphical documents, comprising images. 

 Used by Authors and Researchers. 

 Detect grammatical errors in a text document. 

 
 

 Creating word document 

Create a document 

1. Open Word. Or, if Word is already open, select File > New. 

2. In the Search for online templates box, enter a search word like letter, resume, or invoice. Or, 

select a category under the search box like Business, Personal, or Education. 

3. Click a template to see a preview. ... 

4. Select Create. 

Editing text 

Edit a Microsoft Word document 

1. Open the file that you want to edit. 

2. Choose from the following tasks: Task. Steps. Edit text. Click the. Edit. tab. Select the text that 

you want to edit. Using the tools in the edit toolbar, change the required formatting including 

font style, paragraph alignment, list formatting, and indentation options. Insert images. 

 

Adding and Formatting Numbers- Symbols 
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Microsoft products allow you to organize content using bulleted and numbered lists. 

You can also create customized lists by editing the bullet/number font, color, 

allignment, and icon style. 

 
Bullets 

 
1. Within your Microsoft document, place your cursor or highlight the text where you wish to 

insert a bulleted list. 

2. Under the [Home] tab in the “Paragraph” section, click the [Bullets] drop-down menu. 

3. Choose a bullet style or select "Bullets and Numbering” to create a customized bullet style. 

4. To change the alignment of the bulleted list, from the "Paragraph" section, click the [Aligh 

Text] drop-down menu. 

 

Numbering 

 
1. Within your Microsoft document, place your cursor or highlight the text where you wish 

to insert a numbered list. 

2. the [Home] tab in the “Paragraph” section, click the [Numbering] drop-down menu. 

3. Choose a numbering style or select "Bullets and Numbering” to create a customized 

numbering style. 

4. To change the alignment of the numbered list, from the "Paragraph" section, click the 

[Aligh Text] drop-down menu. 

 
To insert a symbol: 

 

1. From the Insert tab, click Symbol. 

2. Choose the symbol that you want from the drop-down list. If the symbol is not in the list, 

click More Symbols. In the font box, choose the font you are using, click the symbol 

you want to insert, and select Insert. 

 
To insert a special character: 

 

1. From the Insert tab, click Symbol. 

2. Click More Symbols. 

3. Select the Special Characters tab. 

4. Choose the character you want to insert, and select Insert. 
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Getting into Print 

Preview your document 

1. Click File > Print. 

2. To preview each page, click the forward and backward arrows at the bottom of the page. If the 

text is too small to read, use the zoom slider at the bottom of the page to enlarge it. 

3. Choose the number of copies, and any other options you want, and click the Print button. 

 Ms-excel: 

Excel definition: a software program created by Microsoft that uses spreadsheets to organize 

numbers and data with formulas and functions. Excel analysis is ubiquitous around the world 

and used by businesses of all sizes to perform financial analysis. 

Microsoft Excel is a spreadsheet program.    That   means   it's   used   to   create   grids 

of text, numbers and formulas specifying calculations. That's extremely valuable for many 

businesses, which use it to record expenditures and income, plan budgets, chart data and 

succinctly present fiscal results. 

Features of Microsoft Excel 

 Add Header and Footer. MS Excel allows us to keep the header and footer in our 

spreadsheet document. 

 Find and Replace Command. ... 

 Password Protection. ... 

 Data Filtering. ... 

 Data Sorting. ... 

 Built-in formulae. ... 

 Create different charts (Pivot Table Report) ... 

 Automatically edits the result. 

Creating tables using Excel 

1. Open the Excel spreadsheet. 

2. Use your mouse to select the cells that contain the information for the table. 

3. Click the "Insert" tab > Locate the "Tables" group. 
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4. Click "Table". ... 

5. If you have column headings, check the box "My table has headers". 

6. Verify that the range is correct > Click [OK]. 

 

 

Using Tables and Creating Graphs 

1. Enter your data into Excel. 

2. Choose one of nine graph and chart options to make. 

3. Highlight your data and 'Insert' your desired graph. 

4. Switch the data on each axis, if necessary. 

5. Adjust your data's layout and colors. 

6. Change the size of your chart's legend and axis labels. 

 
 

  Ms-access: 

Microsoft Access is an information management tool, or relational database, that helps you store 

information for reference, reporting and analysis. Access can also overcome the limitations 

found when trying to manage large amounts of information in Excel or other spreadsheet 

applications. 

Features 

 Ideal for individual users and smaller team. 

 Easier than client-server database to understand and use. 

 Import and export to other Microsoft Office and other applications. 

 Ready templates for regular users to create and publish data. 

 Allows building and publishing Web databases effortlessly. 

Planning and Creating Tables 

Planning Tables 

1. Plan Tables. Tables are one of the fundamental building blocks of a database. ... 

2. Choose Data Types. When you create a table, you must decide what fields to include and 

the appropriate format for those fields. ... 



49 
 

3. Specify a Primary Key. You should also identify which field or fields are 

the table's primary keys. 

Create a new table in a new database 

1. Click File > New, and then select Blank desktop database. 

2. In the File Name box, type a file name for the new database. 

3. To browse to a different location and save the database, click the folder icon. 

4. Click Create. 

Forms- Modifying tables 

1. Here's the step-by-step process to create your new input form: 

2. Select Create in the menu, and select Form Wizard. 

3. Select the >> button to select all fields in the table. 

4. Select the Next button to continue. 

5. Choose the form layout that you'd like. ... 

6. Select the Next button to continue. 

Modify: 

7. On the Create tab, in the Macros & Code group, click Query Design. 

8. On the Design tab, in the Query Type group, click Data Definition. ... 

9. Type the following SQL statement: ... 

10. On the Design tab, in the Results group, click Run. 

11. Create a primary key for the table by using an ALTER TABLE statement: 

Creating relational Database 

Relational Database Design Process 

1. Step 1: Define the Purpose of the Database (Requirement Analysis) ... 

2. Step 2: Gather Data, Organize in tables and Specify the Primary Keys. ... 

3. Step 3: Create Relationships among Tables. ... 

4. Step 4: Refine & Normalize the Design. 
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Form design- Reports 

Reports offer a way to view, format, and summarize the information in your Microsoft 

Access database. For example, you can create a simple report of phone numbers for all your 

contacts, or a summary report on the total sales across different regions and time periods. 

1. A report consists of information that is pulled from tables or queries, as well as information 

that is stored with the report design, such as labels, headings, and graphics. 

2. The tables or queries that provide the underlying data are also known as the report's record 

source. 

How to make a report: 

1. Balance text with visuals for a digestible report design. 

2. Use a single highlight color to draw attention to key information. 

3. Create a clear text hierarchy for an easy-to-navigate report design. 

4. Incorporate your branding for a cohesive report design. 

 Ms-Powerpoint 

Microsoft PowerPoint is a professional presentation program that allows the user to create 

"presentation slides" that can be displayed on the computer screen or through a projector that is 

plugged into the computer.The program uses slides to convey information rich in multimedia. 

 Customize Color Schemes.

 Add Animation effects.

 Use the Slide, Notes and Handout Masters.

 Create, Edit and Import Charts.

 Create and Edit Tables.

 Manage Hyperlinks.

 Create Custom Shows.

 Export Outlines & Presentation Slides to Word.

 

 

 Introduction- Creating slides and Slideshow 
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A slide is a single page of a presentation. Collectively, a group of slides may be known as 

a slide deck. .... In the digital age, a slide most commonly refers to a single page developed using 

a presentation program such as MS PowerPoint, Apple Keynote, Google Slides, Apache 

OpenOffice or LibreOffice. 

CREATING SLIDES 

1. Open Microsoft PowerPoint. 

2. Go to File at the top of the screen and click New. ... 

3. In the “New Presentation” dialog box, click on “From Design Template.” You may then scan 

through design templates and choose one that you like. 

4. Step 4: Slide Design. ... 

5. Step 5: Slide Layout. ... 

6. Step 6: Adding Text. ... 

7. Step 7: Adding Pictures. 

Slideshow 

Click the Slide Show tab on the ribbon. Select From Beginning or From Current Slide. You can 

also press F5 on your keyboard or click the Slide Show button in the status bar to start 

the presentation. 

  Preparing Power Point Presentation for Marketing 

Products such as CREDIT CARD, Newly Introduced 

Cosmetic item etc., 

Content of this Powerpoint Presentation 

 

 
Slide 1: This slide introduces Example Presentation of Product. State Your Company Name and 

begin. 

Slide 2: This is an Agenda slide. State your agendas here. 

Slide 3: This slide shows Outline as- Product Idea Screening, New Product Analysis, Product 

Lifecycle, Tools & Techniques, Market Analysis, Development Plans, Branding & 
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Repositioning, Cost Analysis, Product Feasibility & Review. 

Slide 4: This slide presents Product Idea Screening describing- New Product Introduction, New 

Product Detailed Overview, Understanding Customer Needs, External Sources of Ideas, Internal 

Sources of Ideas, Product Roadmap. 

Slide 5: This slide displays New Product Introduction. Explain the product idea in detail for e.g. 

Requirement of the product, Technology used etc. 

Slide 6: This slide represents New Product Detailed Overview. 

Slide 7: This slide showcases Understanding Customer Needs describing- What they do: 

Understand their occupation and interest? Understand your customer: are they a small private 

company or a big MNC? When they buy: Understand the purchasing cycle of your customer 

What they expect of you: if your customers expect reliable delivery and you don't disappoint 

them, you stand to gain repeat business How they buy: Website, App, in-person? 

Slide 8: This slide shows External Source of New Product Ideas describing- Overseas experience 

transferring foreign products, Learning From, Competitors, Long Range Studies, Market Gap 

Analysis, Consumer Activity Analysis, Market Research. 

Slide 9: This slide presents Internal Sources of New Product Ideas describing- Management, 

Employee Suggestions, Stockholders, Innovation Group Meetings, Sales Force, Research and 

Engineering. 

Slide 10: This slide displays Product Roadmap as- Product Launch, Data Logging Module, 

Bootstrap upgrade, Teach support portal, Chrome Support, Public API. 

Slide 11: This slide represents New Product Analysis describing- Detailed Analysis, Category 

Analysis - Example Slide, Category Analysis, Porter’s Five Forces Analysis. 

Slide 12: This slide showcases Detailed Analysis with- Strengths, Weaknesses, Features, 

Benefits. 

Slide 13: This slide shows Category Analysis with Positioning Claims/trends, Price, Packing 

formats types & materials, Consumption Drivers. 

Slide 14: This slide presents Category Analysis – Example Slide. 

Slide 15: This slide displays Porter’s Five Forces Model describing- Intensity of Rivalry, 

Barriers to Entry, Substitutes, Bargaining Power of suppliers, Bargaining Power of Buyer. 

Slide 16: This slide represents Product Life Cycle as- Introduction Stage, Maturity Stage, 

Repositioning a Product, Growth Stage, Decline Stage. 
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Slide 17: This slide showcases Product Life Cycle Stages describing- Introduction, Growth, 

Maturity, Decline. 

Slide 18: This slide shows Introduction Stage with- Cost, Targets, Competition, Profits, Sales. 

Slide 19: This slide presents Growth Stage with following points- Promotions, Distribution 

Channels, Pricing, Product Quality. 

Slide 20: This slide displays Maturity Stage. 

Slide 21: This slide represents Decline Stage. 

Slide 22: This slide showcases Tools & Techniques as- BCG Matrix, Empathy Map, Ansoff 

Matrix, Kano Model. 

Slide 23: This slide shows BCG Matrix. 

Slide 24: This slide presents Ansoff Matrix. 

Slide 25: This slide displays Empathy Map to come up with all the possible customer segments 

to whom you might want to sell your product. 

Slide 26: This slide represents Kano Map. 

Slide 27: This slide represents Market Analysis describing- Market Segmentation, Competitive 

Strategies, Product Market Mapping, Market Attractiveness. 

Slide 28: This slide showcases Market Segmentation with factors as- Geographic, Demographic, 

Psychographic, Behavioral. 

Slide 29: This slide shows Product Market Mapping. 

Slide 30: This slide presents Competitive Strategies in a matrix form. 

Slide 31: This slide displays Market Attractiveness. 

Slide 32: This slide represents Development Plans describing- Manufacturing Plan, Marketing 

Launch Plan, Digital Marketing Plan, Operations Plan, Marketing Communication Plan, 

Budgeting Plan. 

Slide 33: This slide displays Manufacturing Plan. 

Slide 34: This slide represents Operations Plan. 

Slide 35: This slide showcases Marketing Launch Plan as- Create Press Release, Update The 

Website, Use Twitter, Garner Endorsements, Attend Tradeshows, Create Email Contest, Build 

Demand, Use Advertising. 

Slide 36: This slide shows Marketing Communication Plan as- Direct Marketing, Public 

Relations, Personal Selling, Sales Promotion, Advertising. 
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Slide 37: This slide presents Digital Marketing Plan. 

Slide 38: This slide displays Budgeting Template in a tabular form. 

Slide 39: This slide represents Branding & Repositioning as- Repositioning Strategy, Maturity 

Stage, Repositioning a Product, Growth Stage, Decline Stage. 

Slide 40: This slide displays Repositioning a Product To new Consumers and Among Existing 

Customers. 

Slide 41: This slide represents Repositioning Strategy in a matrix form. 

Slide 42: This slide displays Building Brand Preference in a tabular form. 

Slide 43: This slide represents Cost Analysis as- Marketing & Launch Cost Analysis, Production 

& Operation Cost Analysis, Business & Financial Analysis. 

Slide 44: This slide showcases Production & Operation Cost Analysis in a tabular form. 

Slide 45: This slide shows Marketing & Launch Cost Analysis. 

Slide 46: This slide presents Business & Financial Analysis. 

Slide 47: This slide displays Product Feasibility & Review with- Evaluating Scores, Product 

Quality Check, Feasibility Review, Alpha & Beta Testing Timelines, Launch Monitoring 

Dashboard. 

Slide 48: This slide represents Feasibility Review describing- Operational Feasibility, Economic 

Feasibility, Legal Requirement Feasibility, Scheduling Requirement Feasibility, Technical 

Feasibility. 

Slide 49: This slide showcases Evaluating Scores in a tabular form. 

Slide 50: This slide shows Alpha & Beta Testing Timelines. 

Slide 51: This slide presents Product Quality Check to rate the product’s quality as per the alpha/ 

beta testing done in the previous slide. 

Slide 52: This slide displays Launch Monitoring Dashboards of Return On Investment, Target 

Units Sold, Customer Satisfaction. 

Slide 53: This slide reminds about 30 minutes Coffee Break. 

Slide 54: This slide shows Example Presentation of Product Icons. 

Slide 55: This is another slide continuing Example Presentation of Product Icons. 

Slide 56: This slide is titled as Additional Slides for moving forward. 

Slide 57: This is Our Mission slide with related imagery. 

Slide 58: This is Our Team slide with names and designation. 
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Slide 59: This is About us slide to show company specifications etc. 

Slide 60: This is Our Main Goal slide. Show your important goals here. 

Slide 61: This is a Comparison slide to state comparison between commodities, entities etc. 

Slide 62: This is Our Main Target slide. Show your targets here. 

Slide 63: This slide displays Australia Map. 

Slide 64: This is a Hierarchy slide with member's names and designation. 

Slide 65: This is a Location slide with USA map. 

Slide 66: This is Contact Us slide with Building Address, Telephone, Email and Business Hours. 
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UNIT IV 
 

 Introduction to Internet 

The Internet is a worldwide network of computer networks that connects university, 

government, commercial, and other computers in over 150 countries. Using the Internet, you 

can send electronic mail, chat with colleagues around the world, and obtain information on a 

wide variety of subjects. 

Internet allows people to improve the quality of their life. It opens access to the previously 

inaccessible things. With almost three millions of users, internet has been emerging as one of the 

most important tools of communication. 

Uses of Internet 

 Online Booking & Orders. ...

 Cashless Transactions. ...

 Education. ...

 Online Banking & Trading. ...

 Research. ...

 Electronic Mail. ...

 Job Search. ...

 Social Networking.

 Resources of Internet 

The most effective communication resources, computers and the Internet, are part of our daily 

life and have become one of the important tools in the education. The Internet helps transfer 

information between different points therefore this satiation makes the Internet a very powerful 

information system. 

A web resource, or simply resource, is any identifiable thing, whether digital, physical, or 

abstract. Resources are identified using Uniform Resource Identifiers. In the 

Semantic Web, web resources and their semantic properties are described using the Resource. 

Advantages of Internet 

 Connectivity, communication, and sharing. ...

 Information, knowledge, and learning. ...

 Address, mapping, and contact information. ...
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 Selling and making money. ...

 Banking, bills, and shopping. ...

 Donations and funding. ...

 Entertainment. ...

 Work from home, collaboration, and access to a global workforce.

 Hardware and Software Requirement of Internet 

The following are the methods of connecting a computer to the Internet using software and 

hardware peripherals. 

 

• Connecting a computer using Wireless Broadband 

 
• Connecting a  computer using an Ethernet Cable 

 
• Connecting a Computer Using Dial-Up Community 

 
Hardware Requirement : 

 
• To connect the Internet, any one of the following is mandatory. 

 
• Modem is used to connect Internet thorugh Telephoneconnection. 

 
• NIC- Network Interface Card(wired/ wireless) facility is the most important hardware required 

to connect Internet. For example, the Laptop can be connected Internet through the 

wired/wireless. 

 

• Dongle is used to connect the Internet using cellular network 

 
• Wi-Fi router or Hotspot is used to connect the Internet using wireless network 

 
• Electronic device which supports cellular network 

 
• Internet Connectivity such as Dial-up connection, ISDN, DSL, Cable TV, wired and wireless 

(Cellular) Network. 



58 
 

Software Requirement 

 
• The operating system should support TCP (Transfer Control Protocol) / IP (Internet Protocol), 

SMTP (Simple Mail Transfer Protocol), FTP (File Transfer Protocol), HTTP (Hyper Text 

Transfer Protocol) and HTTPS (Hyper Text Transfer Protocol Secured) protocols. 

 

• Browsers and other Internet clients access to the web applications such as Outlook, Gmail, 

Whatsapp, Facebook, Twitter and etc. 

 

Connection Types:The following methods are able to connect internet. 

 
Dial-up Connection : 

 
A dial-up connection is established when two or more data communication devices use a Public 

Switched Telephone Network (PSTN) to connect to an Internet Service Provider (ISP) from 

computers. Many remote locations depend on Internet dial-up connections because broadband 

and cable are rare in remote areas with low population. Internet Service Providers often provide 

dial-up connections, a feasible alternative for budget-conscious subscribers. 

 

ISDN 

 
ISDN is the acronym of Integrated Services Digital Network. It establishes the connection 

using the phone lines (PSTN) which carry digital signals instead of analog signals. It is a set of 

communication standards for simultaneous digital transmission of data, voice, video, and other 

services over the traditional circuits of the public switched telephone network. There are two 

techniques to deliver ISDN services such as Basic Rate Interface (BRI) and Primary Rate 

Interface (PRI). 

 

The following diagram shows accessing internet using ISDN connection: 
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DSL: 

 
Digital Subscriber Line (DSL) is a high-speed Internet service for homes and businesses that 

competes with cable and other forms of broadband Internet. DSL provides high-speed 

networking over ordinary Telephone lines using broadband modem technology. The technology 

behind DSL enables Internet and telephone service to work over the same phone line without 

requiring customers to disconnect either their Voice or Internet connections. 

 

Cable TV Internet Connection (setup box): 

 
The cable TV network can be used for connecting a computer or a local network to the Internet, 

competing directly with DSL (Digital Subscriber Line) technology. This type of network is 

classified as HFC (Hybrid Fiber-Coaxial), as it uses both fiber optics and coaxial cables. The 

connection between the cable TV company to the distribution points (Optical nodes) is made 

using fiber optics, with distances up to 25 miles (40 km). Each optical node is typically serves 

between 500 and 2,000 clients (customers).The following diagram shows that how internet is 

accessed using Cable TV connection: 
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Satellite Internet Connection: 

 
Satellite Internet access is Internet access provided through satellite communication for domestic 

and enterprise usage. The facility of modern consumer grade satellite Internet service is typically 

provided to individual users through geostationary satellites. It provides fairly high data speeds, 

along with latest satellites using Ka-band to attain downstream data speeds up to 50 Mbps 

internet speed. 

 

Wireless Internet Connection: 

 
It is a technology for wireless local area networking with devices based on the IEEE 802.11 

standards. Devices that can use Wi-Fi technology include personal computers, video-game 

consoles, phones and tablets, digital cameras, smart TVs, digital audio players and modern 

printers. Wi-Fi compatible devices can connect to the Internet via a WLAN and a wireless access 

point. Such an access point (or hotspot) has a range of about 20 meters (66 feet) indoors and a 

greater range of outdoors. Hotspot coverage can be as small as a single room with walls that 

block radio waves, or as large as many square kilometers achieved by using multiple overlapping 

access points. 
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 Internet service providers 

An Internet Service Provider (ISP) is a company such as AT&T, Verizon, Comcast, or 

Spectrum that provides Internet access to companies, families, and even mobile 

users. ISPs use fiber-optics, satellite, copper wire, and other forms to provide Internet 

access to its customers. 

 Creating an E-Mail Account 

Create a Gmail account 

 
To sign up for Gmail, create a Google Account. You can use the username and password to sign 

in to Gmail and other Google products like YouTube, Google Play, and Google Drive. 

 

1. Go to the Google Account creation page. 

2. Follow the steps on the screen to set up your account. 

3. Use the account you created to sign in to Gmail. 

 

Create an account 

 

The username I want is taken 

 
You won't be able to get a certain Gmail address if the username you requested is: 

 
 Already being used. 

 Very similar to an existing username (for example, if example@gmail.com already 

exists, you can't use examp1e@gmail.com). 

 The same as a username that someone used in the past and then deleted. 

 Reserved by Google to prevent spam or abuse. 

 
Someone is impersonating me 

 
If you believe someone has created a Gmail address to try to impersonate your identity, you can: 

 
 File a report with the Internet Crime Complaint Center. 

https://accounts.google.com/SignUp
https://accounts.google.com/SignUp
mailto:example@gmail.com
https://www.ic3.gov/
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 Contact your state's Office of Consumer Protection. 

 
Unfortunately, Gmail is unable to participate in mediations involving third parties regarding 

impersonation. 

 

Use Gmail for your business 

 
If you want to use Gmail for your business, a Google Workspace account might be better for 

you than a personal Google Account. Google Workspace starts at $6 per user per month and 

includes the following: 

 

 A professional, ad-free Gmail account using your company’s domain name, such as 

susan@example.com. 

 Ownership of employee accounts so you are always in control of your company’s 

accounts, emails, and files. 

 24/7 phone, email, and chat support from a real person. 

 Increased Gmail and Google Drive storage. 

 Mobile device management to keep your data secure, such as the ability to remotely wipe 

lost devices. 

 Advanced security and administrative controls. 

 

  Sending and Receiving Messages with Attachments to 

our friends account

 

Send emails as attachments 

 
You can attach emails to other emails without downloading them first. When you attach an 

email, it becomes an .eml file. 

 

How it works 

 
When you send emails as an attachment: 

mailto:susan@example.com
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 You can attach as many emails as you’d like. 

 If the file size grows over 25 MB, it will attach through Google Drive. 

 When you click on an attached email, it will open in a new window. 

 A security banner will appear at the top of an attached email sent or received 

 
Forward an email as an attachment 

 
1. On your computer, go to Gmail. 

2. Select the emails that you want. 

3. Click More  Forward as attachment. 

4. In the “To” field, add recipients. You can also add recipients in the “Cc” and “Bcc” 

fields. 

5. Add a subject. 

6. Write your message. 

7. At the bottom, click Send. 

 
Note: To forward as an attachment, you can also right-click on a message or drag and drop the 

file into the body of your message. 

 

Reply with an attached email 

 
1. On your computer, go to Gmail. 

2. Open the email click Reply. 

3. At the top right of the email, click the Pop out icon . 

4. From your inbox, select the email you want to attach. 

5. Drag the email into your message. 

6. At the bottom, click Send. 

 

 Introduction to multimedia 
 

Multimedia is an interactive media and provides multiple ways to represent information to the 

user in a powerful manner. It provides an interaction between users and digital information. It is 

http://www.gmail.com/
http://www.gmail.com/
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a medium of communication. Some of the sectors where multimedia is used extensively are 

education, training, reference material, business presentations, advertising and documentaries. 

 

Definition of Multimedia 

 
By definition Multimedia is a representation of information in an attractive and interactive 

manner with the use of a combination of text, audio, video, graphics and animation. In other 

words we can say that Multimedia is a computerized method of presenting information 

combining textual data, audio, visuals (video), graphics and animations. For examples: E-Mail, 

Yahoo Messenger, Video Conferencing, and Multimedia Message Service (MMS). 

Multimedia as name suggests is the combination of Multi and Media that is many types of 

media (hardware/software) used for communication of information. 
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Components of Multimedia 

Following are the common components of multimedia: 

 

 Text- All multimedia productions contain some amount of text. The text can have 

various types of fonts and sizes to suit the profession presentation of the multimedia 

software. 

 Graphics- Graphics make the multimedia application attractive. In many cases people 

do not like reading large amount of textual matter on the screen. Therefore, graphics are 

used more often than text to explain a concept, present background information etc. 

There are two types of Graphics: 

o Bitmap images- Bitmap images are real images that can be captured from 

devices such as digital cameras or scanners. Generally bitmap images are not 

editable. Bitmap images require a large amount of memory. 

o Vector Graphics- Vector graphics are drawn on the computer and only require a 

small amount of memory. These graphics are editable. 

 Audio- A multimedia application may require the use of speech, music and sound 

effects. These are called audio or sound element of multimedia.Speech is also a perfect 

way for teaching. Audio are of analog and digital types. Analog audio or sound refers to 

the original sound signal. Computer stores the sound in digital form. Therefore, the 

sound used in multimedia application is digital audio. 

 Video- The term video refers to the moving picture, accompanied by sound such as a 

picture in television. Video element of multimedia application gives a lot of information 

in small duration of time. Digital video is useful in multimedia application for showing 

real life objects. Video have highest performance demand on the computer memory and 

on the bandwidth if placed on the internet. Digital video files can be stored like any 

other files in the computer and the quality of the video can still be maintained. The 

digital video files can be transferred within a computer network. The digital video clips 

can be edited easily. 
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 Animation- Animation is a process of making a static image look like it is moving. An 

animation is just a continuous series of still images that are displayed in a sequence. The 

animation can be used effectively for attracting attention. Animation also makes a 

presentation light and attractive. Animation is very popular in multimedia application 

 Multimedia and its Applications. 
 

 

Applications of Multimedia 

 
Following are the common areas of applications of multimedia. 

 

 Multimedia in Business- Multimedia can be used in many applications in a business. 

The multimedia technology along with communication technology has opened the door 

for information of global wok groups. Today the team members may be working 

anywhere and can work for various companies. Thus the work place will become global. 

The multimedia network should support the following facilities: 

o Voice Mail 

 

o Electronic Mail 

 

o Multimedia based FAX 

 

o Office Needs 

 

o Employee Training 

 

o Sales and Other types of Group Presentation 

 

o Records Management 

 

 Multimedia in Marketing and Advertising- By using multimedia marketing of new 

products can be greatly enhanced. Multimedia boost communication on an affordable 

cost opened the way for the marketing and advertising personnel. Presentation that have 

flying banners, video transitions, animations, and sound effects are some of the elements 

used in composing a multimedia based advertisement to appeal to the consumer in a way 

never used before and promote the sale of the products. 
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 Multimedia in Entertainment- By using multimedia marketing of new products can be 

greatly enhanced. Multimedia boost communication on an affordable cost opened the 

way for the marketing and advertising personnel. Presentation that have flying banners, 

video transitions, animations, and sound effects are some of the elements used in 

composing a multimedia based advertisement to appeal to the consumer in a way never 

used before and promote the sale of the products. 

 Multimedia in Education- Many computer games with focus on education are now 

available. Consider an example of an educational game which plays various rhymes for 

kids. The child can paint the pictures, increase reduce size of various objects etc apart 

from just playing the rhymes.Several other multimedia packages are available in the 

market which provide a lot of detailed information and playing capabilities to kids. 

 Multimedia in Bank- Bank is another public place where multimedia is finding more 

and more application in recent times. People go to bank to open saving/current accounts, 

deposit funds, withdraw money, know various financial schemes of the bank, obtain 

loans etc. Every bank has a lot of information which it wants to impart to in customers. 

For this purpose, it can use multimedia in many ways. Bank also displays information 

about its various schemes on a PC monitor placed in the rest area for customers. Today 

on-line and internet banking have become very popular. These use multimedia 

extensively. Multimedia is thus helping banks give service to their customers and also in 

educating them about banks attractive finance schemes. 

 Multimedia in Hospital- Multimedia best use in hospitals is for real time monitoring of 

conditions of patients in critical illness or accident. The conditions are displayed 

continuously on a computer screen and can alert the doctor/nurse on duty if any changes 

are observed on the screen. Multimedia makes it possible to consult a surgeon or an 

expert who can watch an ongoing surgery line on his PC monitor and give online advice 

at any crucial juncture. 

In hospitals multimedia can also be used to diagnose an illness with CD-ROMs/ 

Cassettes/ DVDs full of multimedia based information about various diseases and their 

treatment.Some hospitals extensively use multimedia presentations in training their 
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junior staff of doctors and nurses. Multimedia displays are now extensively used during 

critical surgeries. 

 Multimedia Pedagogues- Pedagogues are useful teaching aids only if they stimulate and 

motivate the students. The audio-visual support to a pedagogue can actually help in 

doing so. A multimedia tutor can provide multiple numbers of challenges to the student 

to stimulate his interest in a topic. The instruction provided by pedagogue have moved 

beyond providing only button level control to intelligent simulations, dynamic creation 

of links, composition and collaboration and system testing of the user interactions. 

 Communication Technology and Multimedia Services- The advancement of high 

computing abilities, communication ways and relevant standards has started the 

beginning of an era where you will be provided with multimedia facilities at home. 

These services may include: 

o Basic Television Services 

 

o Interactive entertainment 

 

o Digital Audio 
 

o Video on demand 

 

o Home shopping 

 

o Financial Transactions 

 

o Interactive multiplayer or single player games 

 

o Digital multimedia libraries 

 

o E-Newspapers, e-magazines 
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 Application software

Application software is a type of computer program that performs a specific personal, 

educational, and business function. Each program is designed to assist the user with a particular 

process, which may be related to productivity, creativity, and/or communication. 

The application software list includes: 

 Word processors.

 Graphics software.

 Database software.

 Spreadsheet software.

 Presentation software.

 Web browsers.

 Enterprise software.

 Information worker software.

 

 

 Accounting packages 

A business account software helps in keeping a track on the entire cash inflow and outflow of an 

organization. There are different kind of modules present through which the software works such 

as General Ledger, Account Receivables, Account Payable, etc. The software also manages the 

payroll system and takes care of reporting management. These individual modules are basic and 

can be customized to match the functionalities of any particular industry. For instance, the fund 

accounting system of a non-profit organization will vary from that of a government organization. 

As account management is one of the essential systems of a business, it often comes under the 

Enterprise Resource Planning System (ERP). 

 
Accounting software is a type of application software that is used to keep track of all the 

transactions that are made to or from your business to an individual or another business. To run a 

successful and profitable business, one has to keep records of all the profits and losses that the 

business is going through at any given time. In old times ledger books were maintained to keep 

track of all the transactions, but with modern times this workload has been reduced using the 
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help of technology.There are many different types of accounting software available, and all types 

of businesses use them. Accounting system can be classified in various categories, and 

depending on the circumstances, anyone of them can be used to digitize the records. These are 

classified as follows: 

 

 
› SP READSHEET S 

 

A spreadsheet is an important business accounting tool. In simple words, a spreadsheet boils 

down to this, and it is a document consisting of grids of rows and columns, which makes it easy 

to store different types of relevant data together. Many small businesses rely entirely on 

spreadsheets for maintaining and accessing their financial data. Spreadsheets can be used for 

almost every accounting needs, including but not limited to, creating budges, calculating profits, 

and visualizing this data using graphs and charts. Microsoft Excel is one of the best and most 

widely used spreadsheet software around the globe. If you are running a small business, then 

make sure to check it out. 

 

 
› COMMERCIAL ACCOUNT IN G SOFT WARE 

 

From managing, income, and expenses to keeping track of the financial health of a business, 

commercial accounting software are more than capable of fulfilling every requirement of a small 

to mid-size business’s accounting needs. These software are totally customizable, which means 

businesses can configure them to fit their specific needs.Software such as QuickBooks 

accounting can be used to invoice customers, pay bills, generate reports, and come in handy 

while preparing for taxes. 

 
Other popular choices for commercial accounting systems are FreshBooks accounting and Xero. 

Some of the commercial software may require consulting the vendor to install and configure 

them accordingly and have lengthy installation processes. 
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› ENT ERP RISE ACCOUNT IN G SOFT WARE 

 

Enterprise accounting software allows a business to maintain its financial transactions and data. 

However, its functions go beyond the scope of just accounting processes. Enterprise software has 

different modules to deal with different areas such as billing and payrolls, maintaining the ledger, 

budgeting and forecasting, and more. 

 
Enterprise resource planning software also referred to as ERP software, is programmed in such a 

way that it can handle complex operations for larger companies. Enterprise software combines 

other services such as project planning and workflow management with accounting, meaning the 

software integrates information from different parts of a business into a single database. This 

ensures better data flow between independent parts of a business which depends on a specific 

piece of software that does not have utilities like information sharing, which is very important. 

However, the installation process is quite lengthy, which means it can take up to a year to set it 

up, and it is also highly expensive.This is the reason this software is used by more important and 

more complex businesses and organizations. 

 
› CUST OM ACCOUNT ING SOFT WARE 

 

These are the applications, which are developed according to the particular needs of a business or 

an organization, meaning they are custom made for a specific purpose. Generally, businesses 

only decide to go for this software if their requirements are so specific that they cannot be 

fulfilled by a commercial or enterprise accounting system. But businesses rarely tend to go with 

custom made software as they are buggy and take more time and resources to manage and 

maintain as compared to custom or enterprise software. 

 
Nowadays, as the applications are being developed cloud-based so that users can access their 

data from anywhere in the world, so is the case with accounting software. Businesses can log in 

to their vendor’s site to access the software from anywhere in the globe, and this approach 

proves to be more productive and beneficial as compared to the primitive approach of installing 

in on a particular system and copying the files whenever they are required by other users on 

different systems. 
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 Statistical packages 

Statistical packages are collections of software designed to aid in statistical analysis and data 

exploration. ... Second, statistical packages can provide a unified operating framework and 

common interface for data manipulation, visualization, and statistical analysis. 

 SPSS (IBM) ...

 R (R Foundation for Statistical Computing) ...

 MATLAB (The Mathworks) ...

 Microsoft Excel. ...

 SAS (Statistical Analysis Software) ...

 GraphPad Prism. ...

 Minitab.

 Preparation of financial statements 

The eight steps of the accounting cycle include the following: 

1. Step 1: Identify Transactions. ... 

2. Step 2: Record Transactions in a Journal. ... 

3. Step 3: Posting. ... 

4. Step 4: Unadjusted Trial Balance. ... 

5. Step 5: Worksheet. ... 

6. Step 6: Adjusting Journal Entries. ... 

7. Step 7: Financial Statements. ... 

8. Step 8: Closing the Books. 

 

 
Here are the types of financial statements and tips on how to create them: 

1. Balance Sheet. ... 

2. Income Sheet. ... 

3. Statement of Cash Flow. ... 

4. Step 1: Make A Sales Forecast. ... 

5. Step 2: Create A Budget for Your Expenses. ... 

6. Step 3: Develop Cash Flow Statement. ... 

7. Step 4: Project Net Profit. ... 
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8. Step 5: Deal with Your Assets and Liabilities. 

 

 

 Statistical analysis- SPSS Software 

The SPSS software platform offers advanced statistical analysis, a vast library of machine 

learning algorithms, text analysis, open source extensibility, integration with big data and 

seamless   deployment   into   applications.   Its   ease   of   use,   flexibility   and   scalability 

make SPSS accessible to users of all skill levels. 

SPSS Statistics, the world's leading statistical software, is designed to solve business and 

research problems through ad hoc analysis, hypothesis testing, geospatial analysis and predictive 

analytics. 

 Using SPSS software. 

SPSS is short for Statistical Package for the Social Sciences, and it's used by various kinds of 

researchers for complex statistical data analysis ..... Most top research agencies use 

SPSS to analyze survey data and mine text data so that they can get the most out of 

their research projects. 

Basic steps in data analysis 

1. Get your data into IBM SPSS Statistics. You can open a previously saved 

IBM SPSS Statistics data file, you can read a spreadsheet, database, or text data file, or you 

can enter your data directly in the Data Editor. 

2. Select a procedure. ... 

3. Select the variables for the analysis. ... 

4. Run the procedure and look at the results. 

 

To run SPSS, log in and click Start - Programs - IBM SPSS Statistics - IBM SPSS Statistics 23. 

When SPSS is first started you are presented with a dialog box asking you to open a file. Pick a 

recently opened file or pick "Open another file" from the list on the left. 

 

***** 
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